Demographic Analysis

Demographic Analysis
Assignment 3 (5%) due Feb 4th
Questions in this lab forms up assignment #3.
Submission
 Submission should be in one file including a title page, all maps and write-up in either PDF or WPRD format.
 Save the file as lastname_firstname_geog413_A3 and send it to your lab instructor by email at baip@unbc.ca
with Subject of Geog413 A3
Nearly half the world’s population currently lives in cities. In the twentieth century, the number of city dwellers
increased worldwide. In Canada, one out of 5 people is foreign-born. According to the first data from the 2011 NHS,
Canada had a total of about 6,775,800 foreign-born individuals who arrived as immigrants. They represented 20.6% of
the total population, compared with 19.8% in the 2006 Census and the trend continually grow.
This migration leads to some interesting questions:
 When ethnic group move to urban areas, do they remain the same neighborhoods over time or do they spread
uniformly or in some pattern throughout the metropolitan region?
 Once neighborhoods were segregated, do they remain so or does the segregation abate over time?
 What does this distribution say about the relationship and attitudes for relations between different ethnic
groups?
 What influence do improving economic conditions have on this migration?
In this lab, you will be working with Canadian census data to examine the ethnic population distribution, diversity and
income etc. throughout the Greater Vancouver metropolitan area for the year of 2006 and 2011

Problem
You need to produce some maps and charts for a research team to explore the changing urban demographics of the
Greater Vancouver area
 A demographics research team is examining neighborhood integration and transition by measuring
increasingly multiethnic and multiracial populations. The team would like to see the maps of Aboriginal,
ON_Amer(Other North American), European, Asian populations for the year of 2006 and 2011.
 The team would also like to see diversity indexes as well as the mean centers and directional distribution of
ethnic groups and calculated and displayed for both 2006 and 201l.
 Finally, the team wants to examine the impact of income on diversity by studying the spatial distribution of
median income in 2011 and how that measure correlates to changing neighborhood settlement patterns. The
researchers have requested that the data be displayed in 3D to engage their users.

Deliverables
After identifying the problem, you need to envision the kinds of data displays (maps, graphics, and tables) that will
provide the solution. The following deliverables are required for this exercise.
1. A basemap showing population density for 2011 and 2006. The map should show the population density
classified in graduated color. Discussion of the spatial distribution of population for each year and the
changes from 2006 to 2011 should be included
2. A map showing population percentage for Asian, Aboriginal, European, ON_Amer for 2011. Discuss the
spatial distribution for each ethnic group
3. A map showing diversity indexes for each year(2006,2011). A map showing the percentage of Aboriginal,
ON_Amer, European, Caribbean, LCSA, African, Asian and Oceania population as a bar graph(2011) and
diversity indexes as graduated color for 2011. A short discussion should be included in your analysis
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4. A map showing the mean center and directional distribution of Asian population in 2006 and 2011. Examine
the changes in mean center and directional distribution between 2006 and 2011
5. A map showing distribution of median income for the year of 2011 and 2006 with histogram.
6. A double variable 3D map of diversity index in relation to median income for 2006 and 2011

Data Downloading
All the data required for this lab can be downloaded from census Canada. The data you need are boundary file at
census tract level, the tabular data containing ethnic origins and median income for the year 2006 and 2011
Get the boundary files:
The boundary file is different for each census year, so you need to download the boundary file for each census year







Open a web browser and search for ‘Census Canada boundary file’
Go to the link Boundary files – Statistics Canada
Click 2011 for the Census year, English for Language, ArcGIS for Format.
Click the radio button for Census Tract under Cartographic Boundary File. Click Continue button
Right-click on the file link and save it to your local folder
In the same way download the boundary file for the year of 2006

Download tabular data
The tabular data contains the information we need for analysis that include the ethnic origin and income















In web browser, Go to UNBC library->Collections->Data & Statistics->Canadian Data
Scroll down and find Canadian Census Analyser. Click the link and Click Canadian census analyser@CHASS
Here you need to enter your UNBC credentials, then you will be in the main page of census data
Click 2011 NHS ->Profile of Census Tracts(cumulative)
In step 1, remove all check marks, and click by Province tab and click Vancouver
In step 2, select NHS Profile variables, Click Eth, Relig, Aborig tab->Ethnic origin Total
Here you can select the data you need. Place a check mark for the followings:
o Total population in private households by ethnic origins; Both sexes
 North American Aboriginal origins; Both sexes
 Other North American origins; Both sexes
 European origins; Both sexes
 Caribbean origins; Both sexes
 Latin, Central and South American origins; Both sexes
 African origins; Both sexes
 Asian origins; Both sexes
 Oceania origins; Both sexes
Double check the Selected items to make sure you have the data list above
In step 3, highlight HTML for Screen output, click Submit Query button. Then you will see the result showing
in HTML
Now click File->Save As to save the file and name it as 2011ethnic_origin.html.



Back to 2011 NHS page and click Profile of Census Tracts(cumulative) to download income data
In step 1, Choose British Columbia->Vancouver
In step 2, click Inc tab and individuals Inc. 2010, place a check mark for the following
o Total income in 2010 of population aged 15 years and over; Both sexes
 Median income; Both sexes
 Average income; Both sexes
Submit the query and save the file as 2011_incom.html



Back to the main page and download 2006 data. The data for 2006 is a bit different
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Click year 2006-> Profile of Census Tracts (cumulative)-> Ethnic origin and visible minorities
Highlight British Columbia->Vancouver[933](B.C.)
Highlight the followings to download
o Total population by ethnic origin – 20% sample data
 Aboriginal
 Other North American origins
 Caribbean origins
 Latin, Central and South American origins
 European origins
 African origins
 Arab origins
 West Asian origins
 South Asian origins
 East and Southeast Asian origins
 Oceania origins




Place a check mark for CTUID to include it in the result. This filed will be used as join item later
Highlight HTML for Screen output and click Submit Quer. Save it as 2006ethnic_origin.html



Back to 2006 main page -> Profile of Census Tracts (cumulative) -> Income and earnings and housing and
shelter costs
o Total income in 2005 of population 15 years and over - 20% sample data
 Median income
 Average income
Include CTUID in the result and save the file as 2006_income.html



Examine the data
Thoroughly investigate the data layers to understand how they will help you address the problem. The spatial
coordinate system, the resolution of the data, and the attribute data are all important pieces of information about a
feature class.

Examine tabular data
As the heading of each column is too long and wouldn’t work for ArcGIS, you need to rename them to a shorter name
 Run LibreOffile Calc from Start->All programs->LibreOffice. Open the file 2011ethnic_origin.html. Click
OK if any popup warning
 Delete the first two rows to remove the title. Scroll down to the end of file and delete any rows with text
 Rename each column heading accordingly:
o Total population in private households by ethnic origins; Both sexes (v168) -> TOT_POP
 North American Aboriginal origins; Both sexes -> Aboriginal
 Other North American origins; Both sexes -> ON_Amer
 European origins; Both sexes -> European
 Caribbean origins; Both sexes -> Caribbean
 Latin, Central and South American origins; Both sexes -> LCSA
 African origins; Both sexes -> African
 Asian origins; Both sexes -> Asian
 Oceania origins; Both sexes -> Oceania
 Click File->Save As. Choose dBASE for the file type and save it as 2011ethnic_origin.dbf
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Open 2006ethnic_origin.html in LibreOffile. Here you need to do some editing
Remove the title rows and the bottom text as you did for 2011 data
Add a new column Asian and give the total of West Asian, South Asian, East and Southeast Asian to this
column.
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Rename the column heading accordingly
o Census Tract Name -> CTName
o CTUID(CMA/CA code + CT name -> CTUID
o Total population by ethnic origin – 20% sample data ->TOT_POP
 Aboriginal -> Aboriginal
 Other North American origins -> ON_Amer
 Caribbean origins ->Caribbean
 Latin, Central and South American origins ->LCSA
 European origins -> European
 African origins ->African
 Arab origins -> Arab
 Oceania origins -> Oceania
 Asian -> Asian
Save the file as 2006ethnic_origin.dbf



Open 2011_incom.html in LibreOffile and rename the heading as the following
o Total income in 2010 of population aged 15 years and over; Both sexes -> TOT_In
 Median income $; Both sexes -> Med_In
 Average income $; Both sexes -> Ave_In
Save the file as 2011_incom.dbf



In the same way rename the 2006 income data. Save the file as 2006_income.dbf

Examine boundary data
The boundary files are in geographic projection for both 2006 and 2011 year






First you need to unzip the downloaded file. Go to your local folder and right-click the zipped file for 2011
and unzip it in the same directory. You will have the boundary file something like gct000b11a_e.shp
In the same way, unzip the file for 2006. You will have two shape files gct000b11a_e.shp and
gct000b06a_e.shp
Open a new map file and add these two shape files
Set the data frame coordinate system to BC Albers (you can import the coordinate system from BC layer
under L:\labs\geog413/bc folder
Make a selection from each layer with the following expression to extract greater Vancouver area
CMAUID = ‘933’ (single quotation)









Export the selected features from each layer and save it as ct2011_van and ct2006_van respectively using the
coordinate system of the data frame (BC Albers). This will reproject the data to BC Albers coordinate system
and make the AREA calculation easier later
Remove the original layers and just keep ct2001_van and ct2006_van in the data frame.
Add table of 2011ethnic_origin,dbf, 2006ethnic_origin.dbf.
Examine the field of CTUID in ct2011_van and GEO_UID in 2011ethnic.origin.dbf. These two fields should
be the join item. The data type of CTUID is in text string while GEO_UID is numeric. This will cause problem
when joining two tables. You need to make the joining field in the same data type.
Open the attribute table of ct2011_van. Add a field CTUID_NUM with 15 for precision and 2 for scale.
Now assign the value from CTUID to the field of CTUID_NUM with field calculator. The field
CTUID_NUM will be used for joining field
In the same way add a field to ct2006_van and assign the value from CTUID.

Analysis
2019
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Set the environments
In GIS analysis, you will often get data from several sources, and these data may be in different coordinate system
and/or map projections. When using GIS to perform area calculation, you would like your result to be in familiar units.
This can be done by setting environment variables




Set environment as the following:
Current /Scratch Workspace:
Output Coordinate System:

your local folder
BC Albers

Save the map file as pop_density.mxd

Step 1: Create a based map of population density for Greater Vancouver
First, you will prepare a basemap showing the 2011 census tracts displayed by population density. The population
density should be classified in graduated color.
1. Add a new field AREA and calculate the area in square kilometer for each layer
2. Examine 2011ethnic_origin table. This table contains ethnic origin and population for each census tract,
which can be joined to ct2011_van for spatial analysis. The join item is CTUID_NUM in ct2011_van and
GEO_UID in 2011ethnic_origin. Join 2011ethnic_origin table to ct2011_van and export it as my_ct2011.
Remove ct2011_van
3. In the same way join table 2006ethnic_origin to ct2006_van and export it as my_ct2006. Remove ct2006_van
The join item is CTUID_NUM in ct2006_van and CTUID in 2006ethnic_origin (Note: it is different from
2011 data)
4. Rename the data frame name to “Population Density 2011”. Turn off all layers except my_ct2011
5. Classify my_ct2011 using graduated color with proper color ramp. The TOT_POP should be used for Value
field and normalized by AREA. Classify the data by manually altering the class breaks. In this case you could
classify the data in 6 classes and use class breaks of 200, 500; 1000; 2000; 5000, and the highest number for
the last class.
6. The number labels should be formatted to show 0 decimals in map. In the symbology window, right-click on
Label (heading) ->Format Label. Set 0 to Number of decimal places. Click OK
7. Copy the “Population Density 2011” data frame and paste it in the table of contents. Rename it to “Population
Density 2006”.
8. In the new data frame, turn off my_ct2011 and turn on my_ct2006. Repeat step 5 to produce a population
density map for 2006.
9. Create a based map showing Greater Vancouver population density for 2011 and 2006 with proper
cartographic principles.
10. Save the map document as pop_density.mxd
Deliverable 1: A basemap showing population density for 2011 and 2006. The map should show the population
density classified in graduated color. Discussion of the spatial distribution of population for each year
and the changes from 2006 to 2011 should be included

Step 2: Compare race/ethnicity for 2006 and 2011
To compare data, you need to create a standard classification that can be used for both years. This can be done by
creating a layer definition and applying it to both the 2006 and 2011 data.
1.
2.
3.
4.
5.
2019

Save the map document again as comparison.mxd.
Remove the data frame “Population Density 2006”
Rename the data frame “Population Density 2011” to “Percentage Asian 2011”
Turn on my_ct2011 and turn off my_ct2006
In “Percentage Asian2011” data frame, classify the 2011 data using graduated color with Asian as the Value
field and TOT_POP as the normalization field. Choose proper color ramp and classify the data by manually
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altering the class breaks. In this case the normalized value cannot greater than 1, which represents 100 percent.
Suggested break values could be 0.2, 0.4, 0.6, 0.8 and 1.0. Format the labels as Percentage.
6. Right-click my_ct2011 -> Save as Layer File and save the layer file with proper name, such as
pop_percent.lyr for later use
It is important to note that the layer file that is used to symbolize all the data must include the maximum value possible
in any of the layers.
7. Copy the “Percentage Asian 2011” data frame and paste. Rename the duplicate data frame to “Percentage
Aboriginal 2011”.
8. In the Symbology window of my_ct2011, import the pop_percent.lyr layer file that you are using as the
standard symbology and change the Value Field to Aboriginal and corresponds population for Normalization
Field (TOT_POP)
9. Repeat the step 7,8 for ON_Amer, European
10. Create a four-data-frame layout using correct cartography principles showing the percentage of Asian,
Aboriginal, European, ON_Amer for the year 2011.
11. Save the map document as comparison2011.mxd.
12. Save the map document again as comparison2006.mxd
13. Turn off my_ct2011 and turn on my_ct2006 in each data frame. Repeat steps above to produce a map for the
year 2006
Deliverable 2: A map showing population percentage for Asian, Aboriginal, European, ON_Amer for 2011. Discuss
the spatial distribution for each ethnic group
These questions may help focus your analysis
Q. Why should you normalize that data?
Q. How does the normalized data differ from the original data?
Q. Describe the distribution of the Asian, European, and how it changed between 2006 and 2011
Q. Do you notice anything about the physical geography where there are large percentages?

Step 3: Calculate the population diversity index for 2006 and 2011
There are many ways to measuring distribution of population. Diversity index is a simple way to look at the
differences. In this step, you will calculate the diversity index for 2006 and 2011, make observations about diversity in
Greater Vancouver, and compare diversity in 2006 with that observed in 2011.

A. Calculate diversity index for 2011
1. Open a new map file and add my_ct2011. Export it as my_ct2011_DI. Remove my_ct2011. Save the map file
as diversity.mxd. Change the name of data frame to Diversity Index 2011
2. Open the attribute table of my_ct2011_DI. This attribute table is long. You can hide some fields not needed by
opening the properties window and go to Fields tab. Here you can toggle a field on/off. The following fields
should remain visible: TOT_POP, Aboriginal, ON_Amer, European, Caribbean, LCSA, African, Asian and
Oceania. Save the map document.
3. In order to calculate the diversity, the percentage of each attribute (Aboriginal, ON_Amer, European,
Caribbean, LCSA, African, Asian and Oceania) is required, you need to add fields and make any necessary
calculations. Percentage calculations will include decimals so that the field should be float or double type. Add
following fields to my_ct2011_DI with Double type, precision at 15 and scale at 3:
PER_ABO
PER_AFR

PER_ONA
PER_ASI

PER_EUR
PER_OCE

PER_CAR
PER_LCSA

DIV_INDEX

4. With the Field Calculator calculate the percentage of each ethnic groups
 Select by attributes Aboriginal > 0 and TOT_POP >0
 With the Field Calculator calculate the PER_ABO field by using the formula Aboriginal /TOT_POP.
2019
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If you examine the data, you can see that some the field values are <NULL>. The <NULL> values
need to be set to 0.
 Switch Selection. Use the Field Calculator to enter 0 for the value <NULL> if necessary
5. Repeat the previous step for PER_ONA, PER_EUR, PER_CAR, PER_LCSA, PER_AFR, and PER_ASI,
PER_OCE. Make sure to use the appropriate selection criteria
We will use a simple formula below to calculate the diversity index (DIV_INDEX)
1-([PER_ABO]^2 +[PER_ONA]^2+[PER_EUR]^2 +[PER_CAR]^2+[PER_LCSA]^2
+[PER_AFR]^2+[PER_ASI]^2 +[PER_OCE]^2)

6. With Field Calculator, calculate DIV_INDEX field using the formula above. Display the DIV_INDEX in
graduated colors and exclude values of 1or greater. Exclusion can be found under the Classify tab in the
graduated colors menu or you can exclude values by using a Definition Query of DIV_INDEX < 1.
7. Create a layer file to use for comparing the diversity index in different years. Symbolize manually with five
classes. Suggested values could be 0.2, 0.4, 0.6, 0.8, 1.0. Format the labels properly, higher values of the
diversity index indicate greater ethnic diversity.
8. Save the layer file as div_index.lyr and save the map document to diversity.mxd

B. Calculate the diversity index for 2006
1. Inset a new data frame and follow the same produce calculate diversity index for 2006. Note: there is an
ARAB group which does not exist in 2011 data. Make sure not forget to include this field
4. Symbolize DIV_INDEX by importing the div_index.lyr layer file. Save the map file to diversity.mxd
5. Compare the 2011 diversity index to the 2006 diversity index.
6. Save the map file to diversity.mxd

Step 4: Examine diversity of individual census tracts
1. Insert a new data frame and name it “Individual Census Tracts 2011”. Copy the layer ct2011_DI and paste it
twice in the “Individual Census Tracts 2011” data frame. Don’t forget to set the coordinate system for the new
data frame.
2. In the Symbology tab, display the top layer by Bar/Column with Aboriginal, ON_Amer, European, Caribbean,
LCSA, African, Asian and Oceania normalized by TOT_POP. Make the background color hollow so you can
see the 2011 classified diversity index layer as well.
3. Save the map file to diversity.mxd.
Deliverable 3: A map showing diversity indexes for each year(2006,2011). A map showing the percentage of
Aboriginal, ON_Amer, European, Caribbean, LCSA, African, Asian and Oceania population as a bar
graph(2011) and diversity indexes as graduated color for 2011. A short discussion should be included
in your analysis
These questions may help focus your analysis:
Q. Where are the clusters of high diversity and where are there clusters of low diversity??
Q. What does low diversity mean?
Q. In what ways did the diversity index change between 2006 and 2011?
Q. Closely investigate Greater Vancouver by zooming in. What do you observe about the diversity of
the census tracts?

Step 5: Calculate mean center and directional distribution
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The mean center identifies the geographic center (or the center of concentration) for a set of features. It is useful for
tracking changes in the distribution of ethnic groups over time.
Directional distribution measures the compactness of a distribution and show the degree to which a distribution varies
north to south (y-axis) and east to west (x-axis).
1. Save the map file as mc_dd.mxd. Remove the Individual Census Tracts data frame and the Diversity Index
2011 data frame.
2. Rename the Diversity Index 2006 to “Statistics 2006 – 2011”
3. You should have my_ct2006_DI and my_ct2011_DI. If not add them to data frame.
4. Calculate the mean center for the percentage of Asian for my_ct2006_DI. Give the output features appropriate
names such as mc_asian06. Use PER_ASI (ASIAN percentage) as the Weight Field.
ArcToobox->Spatial Statistics ->Measuring Geographic Distributions->Mean Center
Input Feature Class: my_ct2006_DI
Output Feature Class: mc_asian06
Weight Field:
PER_ASI
5. Repeat previous step to create mean center for ct2011_DI. Save the output feature as mc_asian11
6. Calculate the directional distribution for the percentage of Asian (PER_ASI) for ct2006_DI. Give the features
appropriate names such as dd_asian06. Use 1 standard deviation for Ellipse Size and PER_ASI as the Weight
Field.
ArcToobox->Spatial Statistics ->Measuring Geographic Distributions->Directional Distribution
Input Feature Class:
my_ct2006_DI
Output Feature Class:
dd_asian06
Weight Field:
PER_ASI
Ellipse Size:
1_STANDARD_DEVIATION
7. Repeat steps 4, 5 and 6 using percentage European (PER_EUR).
8. Label appropriately and show the mean center and directional distribution over time. Save the map file
9. You can examine other groups the same way
Deliverable 4: A map showing the mean center and directional distribution of Asian population in 2006 and 2011.
Examine the changes in mean center and directional distribution between 2006 and 2011
These questions may help focus your analysis
Q: Do the mean centers for Asian very over time?
Q: What would cause the mean centers to shift?
Q: How did the mean centers shift between 2006 and 2011?
Q: Do the directional distributions very between 2006 and 2011?
Q: Why would directional distributions change?
Q: What can you tell about changes in segregation from these map?

Step 6: Analyze distribution and change in median income
Many factors can affect diversity in an urban setting, but economics is one of the most powerful forces. Income can
serve as an economic indicator that can help you understand the changing patterns of diversity. Think about other
indicators (such median house value etc.) you might use to explore this situation.

Prepare the map
1. Open a new map file and add ct2011_van and 2011_income.dbf to ArcMap
2. Rename the data frame to “Median Income”
3. Joint the 2011_income to the layer ct2011_van. The joining field is GEO_UID in 2011_income and
CTUID_NUM in ct2011_van. Export it as income_ct2011. Remove the ct2001_van and 2011_income
4. Display income_ct2011 by Graduated Color using the Med_in for Values field. Classify the data in 5 classes
with value break as 20000, 30000, 35000, 40000, 60000. Reformat the labels with proper cartography
principles. Save it as a layer file med_income.lyr
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5. Add a new data frame and add ct2006_van, 2006_income.dbf. Repeat 2 – 6 for the year of 2006. Save the
map file as med_incom.mxd

Create a histogram of median income in 2011
1. Create a Histogram Graph using my_income_ct2011with the Graphs tool(View->Graph->Create Graph). Set
the Value field to Med_in.
2. Title and label the legends appropriately. Include the graph on the layout
3. Create a histogram graph for 2006
4. Save the map file as med_incom.mxd
The graph is dynamically linked to the map. As you click a histogram bar, the census blocks with median income in
the range are highlighted on the map. Starting at left (lowest median income). Click each section of the histogram.
Observe the spatial patterns on the map.

Deliverable 5: A map showing distribution of median income for the year of 2011 and 2006 with histogram. Think
about the following questions in your map analysis
Q. What does the median income represent and what is the lowest and highest median income?
Q. Describe the spatial distribution of median income in Greater Vancouver area
Q. Explain the patterns that you see in the graph.
Q. Any changes on median income from 2006 to 2011?

Step 7: Prepare a double variable map showing the relation between diversity index
and median income in 3D
Use ArcScene to display the data in 3D. The height of individual features is provided by either using base height
(elevation) data or extruding features by particular attribute values.
You can control the vertical exaggeration, which allows you to exaggerate the difference in features to help you
analyze variation in your data. While this technique is often very useful, you must not forget that ArcScene has
exaggerated the view which might lead you to draw some very erroneous conclusions.
1. Open ArcScene. Set the scene document properties. Select “Store relative pathnames to data sources”. Set the
data frame properties coordinate system and Set the environment
2. Add my_ct2011_DI and 2011_income. Join 2011_income to my_ct2011_DI
3. Export the my_ct2011_DI and save the file as tractsdi_income_2011. Remove my_ct2011_DI and the
2011_income
You now have one feature class with the diversity index and the median income include.
4. Display tractsdi_income_2011 by graduated color using the Med_in field and exclude 0.
5. Extrude the feature class by the diversity index and Calculate from Extent Vertical Exaggeration.
6. Save the map file as van_di_med_in
7. You can play around for 2006

Step 8: Prepare 3D race/ethnicity maps relating to 2011 median income
1. Open ArcScene and add tractsdi_income_2011
2. Symbolize tractsdi_income_2011 by importing the pop_percent.lyr file from step 2. Select Asian for value
field and TOT_POP for Normalization Field
3. Extrude by the attribute Med_in. Click the Calculate From Extent button to set the vertical exaggeration
4. Repeat for European, Aboriginal, and ON_Amer population percentages and observe their variations with
respect to the extruded median house value.
5. Record your observations as you examine each of the sense to help you in your analysis

Deliverable 6: A double variable 3D map of diversity index in relation to median income for 2006 and 2011.
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Address the following questions in analyzing your map:
Q. What other variables might you analyze to understand the changing patterns of diversity in greater
Vancouver area?
Discuss on overall results. How has the distribution of ethnic group (Asian, European) in the Greater Vancouver area
changed between 2006 and 2011? Can you predict what changes might be seen in the future?
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